
Khoa Điện – Điện tử   Tài liệu thực hành mạng máy tính 

Bài 1: Windows Xp trong môi trường mạng Workgroup 
 

1. Users và Groups 
a. Tạo user:  

Lần lượt tạo 3 tài khoản có username là user01, user02, user03 theo 3 cách sau:  
Cách 1: Control panel  User Accounts  Tạo tài khoản user01 với: 

Username:   user01 
  Password:   1234 
  Kiểu tài khoản:  Computer administrator 
 

   
 

   
 

 Câu hỏi:  
- Cho biết sự khác nhau giữa kiểu tài khoản computer administrator 

và limited ? 
- Cho biết ý nghĩa của password hint ? 

Cách 2: Nhấp phải My Computer / Manage  Computer management / 
Local users and groups / Users  Tạo tài khoản user02 với: 

Username: user02 
  Password: 1234 
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 Câu hỏi:  
Cho biết ý nghĩa của 4 tùy chọn: User must change password at 
next logon, User cannot change password, Password never 

expired và Account is disabled ? 
Cách 3: Trên dòng lệnh  Tạo tài khoản user03 với: 

Username: user03 
  Password: 1234 

  >> net  user  user03  1234  /add 

 
 

 Câu hỏi:  
Với 3 cách tạo user như trên, cách nào cho phép tạo tài khoản dễ dàng, 
nhanh chóng và tiện lợi? 

b. Sử dụng welcome screen và fast user switching 
Lần lượt thực hiện các bước sau: 
• Control panel / User Accounts  Chọn Change the way user 

log on or off  Đánh dấu chọn Use fast user switching  Chọn 
Apply options 

• Start / Logon off  Chọn switch user  Quan sát trên màn hình 
welcome screen 

• Logon user01  m  ứng dụng MS Word 
• Start / Logoff  Chọn switch user  Quan sát trên màn hình 

welcome screen 
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 Câu hỏi:  
Cho biết ý nghĩa của chức năng Use fast user switching? 

• Logoff tất cả các user đang logon  logon vào bằng administrator 
• Control panel / User Accounts  Chọn Change the way user 

log on or off  Bỏ chọn Use the welcome screen  Chọn Apply 
options 

• Start / Logoff  Quan sát trên màn hình Welcome to Windows 
 Câu hỏi:  

Cho biết ý nghĩa của chức năng Use the welcome screen?  

c. Tạo group, members of group 
• Computer management / Local users and groups / Groups  

Tạo nhóm students với: 
Group name: students 
Members:   user01, user02, user03 
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 Câu hỏi:  
Cho biết ý nghĩa của nhóm (group)? 

2. Các thành phần nối mạng: 
a. Computer name, workgroup 

• Control panel / System / Computer name  Quan sát computer 
name và workgroup 

• Tiến hành đổi computer name  kh i động lại máy 
 

 
• Tiến hành đổi tên workgroup theo tên của nhóm thực hành  kh i động lại 

máy 
• My network places / Entire network / Microsoft Windows 

Network  Tìm nhóm làm việc của máy  Quan sát 
 Câu hỏi:  

Cho biết ý nghĩa của workgroup? 
b. Network connection: 

• Control panel / Network connections  Quan sát và ghi nhận các 
giao tiếp mạng hiện có trên máy.  

• Chọn giao tiếp mạng đang chạy  Properties  Quan sát các thành phần nối 
mạng hiện có 

Client for Microsoft networks 
r Microsoft networks File and printer sharing fo

nternet protocol (TCP/IP) I
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 Câu hỏi:  
Cho biết vai trò của các thành phần mạng trên? 

3. Địa chỉ IP:  
a. IP address: 

• Run / cmd  ipconfig /all  Quan sát và ghi nhận các thông số: IP 
address, Network mask, Default gateway, DNS server, DHCP 

sever,…  Địa chỉ được cấp động 
 

 
 

 Câu hỏi:  
Cho biết địa chỉ máy được cấp động từ server có địa chỉ bao nhiêu ? 

• Control panel / Network connections  Chọn giao tiếp mạng đang 
chạy  Properties  Internet protocol TCP/IP  Chuyển sang 
khai báo địa chỉ tĩnh 

IP address:   192.168.1.X (X trong khoảng 30-100) 
Subnet mask:   255.255.255.0 
Default gateway:  192.168.1.1 
DNS server:   192.168.1.2, 203.162.4.190 
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 M  IE và truy cập internet  
b. DNS server  

• Trong cấu hình TCP/IP loại bỏ địa chỉ của các DNS server  
M  IE để truy xuất trang http://www.saigon-uni.edu.vn  ghi nhận 
kết quả 
M  IE để truy xuất trang http://210.245.32.233  ghi nhận kết quả 

 Câu hỏi:  
Cho biết ý nghĩa của các địa chỉ DNS server trong cấu hình TCP/IP? 

c. Default gateway 
• Trong cấu hình TCP/IP thêm lại địa chỉ của các DNS server, loại bỏ địa chỉ của 

default gateway 
M  IE để truy xuất trang http://www.saigon-uni.edu.vn  ghi nhận 
kết quả 
M  IE để truy xuất trang http://www.tuoitre.com.vn  ghi nhận kết 
quả 

 Câu hỏi:  
Cho biết ý nghĩa của default gateway trong cấu hình TCP/IP? 

4. Các công cụ hỗ trợ TCP/IP 
a. Ping:  

• Thực hiện lần lượt các lệnh sau trên dòng lệnh và ghi nhận kết quả 
ping 192.168.1.Y 
ping 192.168.1.254 
ping 203.162.4.190 
ping www.yahoo.com 
ping www.tuoitre.com.vn 

 Câu hỏi:  
Cho biết ý nghĩa của lệnh ping, cho biết các kết quả thu được trong các 
trường hợp khác nhau như thế nào ?  

• ping 127.0.0.1 
ping localhost 

 Câu hỏi:  
Cho biết ý nghĩa của lệnh ping trong 2 tình huống trên?  

b. Tracert 
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 Câu hỏi:  
Cho biết ý nghĩa của lệnh tracert ? Cho biết thông số hop có ý nghĩa gì? 

c. Nslookup 
• Thực hiện lần lượt  

nslookup  www.saigon-uni.edu.vn  203.162.4.190 
nslookup  www.saigon-uni.edu.vn  203.113.131.1 
nslookup  www.saigon-uni.edu.vn  

 Câu hỏi:  
Cho biết ý nghĩa của lệnh nslookup? Sự khác biệt giữa 3 trường hợp trên? 

• Thực hiện lần lượt  
nslookup  203.162.4.190  192.168.1.2 
nslookup  203.113.131.1  203.162.4.190 

 Câu hỏi:  
Cho biết ý nghĩa trong 2 tình huống trên? 

d. Ipconfig:  
Lưu ý: Đặt tất cả các máy  cấu hình nhận địa chỉ cấp phát động 

• Trên dòng lệnh, thực hiện: 
ipconfig  /release 
ipconfig  /all 

 Nhận xét 
ipconfig  /renew 
ipconfig  /all 

 Nhận xét 
 Câu hỏi:  

Cho biết ý nghĩa cách dùng lệnh ipconfig trong các trường hợp trên? 
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Bài 2: Windows Xp sử dụng tài nguyên mạng 
 

Các máy xác nhận các thông số:  
 Computer name:  STU-XXS 
 Username:  userXX 
 Password:  1234 
 Mail account:  userXX@ddt-stu.edu.vn 
  Trong đó:  XX là số theo thứ tự của máy 

1. Sử dụng các tài nguyên trên mạng 
a. Các ổ đĩa mạng: 

• Vào run gõ: \\teacher  Nhập theo yêu cầu các thông tin về username và 
password 

 

    
 

 
 

 Quan sát tất cả các chia sẻ mà server cung cấp cho người dùng 
Nhấp chọn để xem nội dung các chia sẻ software, share, … 
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• Vào Windows Explorer / Tools / Map network drive  Nhập 
thông tin: 

Drive: W 
Folder:  \\192.168.1.8\software 

 

 
 

 Nhận xét 
 Câu hỏi:  

Cho biết sự khác biệt giữa 2 cách xem tài nguyên mạng? 
• Thực hiện tương tự: 

Y  \\192.168.1.8\data$\computername 

X  \\192.168.1.8\share 

 Nhận xét về khả năng ghi, xóa, đọc trên các ổ đĩa mạng 
 Cho biết các ổ đĩa nào là ổ đĩa sử dụng chung cho các máy và ổ nào là ổ 

đĩa dành riêng cho mỗi máy ? 
• Windows Explorer  right click đĩa Y  Chọn Disconnect 

 

 
• Windows Explorer / Tools / Disconnect network drive  lần 

lượt chọn các ổ đĩa mạng muốn ngắt kết nối 
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 2 cách làm trên có khác biệt gì? 

• Lần lượt ngắt tất cả kết nối mạng 
b. Lệnh net use: Trên dòng lệnh lần lượt nhập vào từng lệnh sau:  

• net  use  W:  \\192.168.1.8\software 

• net  use  X:  \\192.168.1.8\share 
 

 
 quan sát và nhận xét 

• net  use  X:  /delete 

 Câu hỏi:  
Nhận xét 2 cách ánh xạ và ngắt kết nối các ổ đĩa mạng ? 

c. Shared printer: Tiến hành cài đặt để sử dụng các máy in được chia sẻ trên server 
• Start / Settings / Printers and Faxes  Add printer  

Next  Chọn Network printer,..  Connect to this printer 

 Trong ô Name nhập vào: \\teacher\HP_laser_6L   Next  
Finish 
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• Tương tự cho máy in HP_laser_6P 
• M  ứng dụng MS Word, lần lượt in trên các máy in mạng khác nhau 

 Câu hỏi:  
- Lợi ích của việc sử dụng máy in chia sẻ qua mạng ? 
- Biểu tượng của máy in mạng và máy in cục bộ khác nhau như thế nào ? 

2. Cấu hình mail client:  
a. Cấu hình Outlook Express để sử dụng mail cục bộ 

• Start / Programs / Outlook Express  Lần lượt nhập thông tin: 
Display Name:    họ và tên của người sử dụng 
Email address:    userXX@ddt-stu.edu.vn 
Incoming mail server: mailser.ddt-stu.edu.vn 
Outgoing mail server: mailser.ddt-stu.edu.vn 
Account name:   userXX 
Password:1234 
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• Các máy lần lượt g i và nhận mail với các máy khác 

 Hiểu các khái niệm mailbox, account mail, mail server, inbox, 
outbox, reply, …  

b. Truy xuất hộp thư qua web: 
• Trên Internet Explorer nhập đư ng link: http://mailser.ddt-

stu.edu.vn:3000 
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• Nhập thông tin tài khoản hộp thư  Thử g i nhận mail 

 Câu hỏi:  
Hai cách truy xuất hộp thư được dùng trong các trường hợp nào ? 

3. Hỗ trợ từ xa với Remote assistance 
Hai máy  1 nhóm bao gồm: helper và user 
a. User: ngư i cần trợ giúp 

• Start / Programs / Remote Assistance  Invite someone to 

help you  Nhập các thông số: 
Outlook Express:  userXX@ddt-stu.edu.vn (email của 
helper) 
From:   [Người có yêu cầu trợ giúp] 
Message:   “Đề nghị hỗ trợ cài đặt Office 
2007” 
Password:   4321 

 

  
 

  
 

• Chọn send Invitation 
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b. Helper: Ngư i được yêu cầu hỗ trợ 
• M  Outlook Express để nhận mail, download Invitation về và thực 

thi. Nhập vào password giống như ngư i yêu cầu đã đặt.  

 
 

   
 

c. Tiến hành trợ giúp 
• Bên user xuất hiện yêu cầu kết nối từ helper, chấp nhận 
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• Helper có thể quan sát desktop của user, tiến hành hỗ trợ từ xa bằng cách 
chat hay voice 

 
 

• Trư ng hợp helper yêu cầu Take Control, user chấp nhận  Helper tiến 
hành điều khiển máy user từ xa. 

 

    
 

 Câu hỏi:  
Ý nghĩa của password và set the invitation to expire trong một 
invitation ? 
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Bài 3: Kết nối và chia sẻ trên Windows XP 
 

Hai máy tạo thành nhóm thực tập: máy A và máy B 
Máy A lần lượt tạo:  (XX là số theo thứ tự của máy) 
 Các user:   userXX  password: 1234 

adminXX  password: 1234 
 Các group:  sinhvien có thành viên là userXX, adminXX 
    Admingroup có thành viên là adminXX 
 Thư mục:  F:\soft 
    F:\data 
 Máy in cục bộ: HP LaserJet 6L (nối cổng LPT1) 
    HP LaserJet 6P (nối cổng LPT2) 

1. Chia sẻ tài nguyên trên máy windows XP: 
a. Share folder:  

o Trên máy A:  
Right click trên thư mục F:\Soft  chọn Sharing and Secirity… 

 Sharing  Đánh dấu chọn Share this folder  Các thông số: 
 Sharename:  software 

 user limit:  2 

 permissions:  admingroup   Full Control 

sinhvien    Read 

everyone    remove 
 

 
 

 
Chọn tag Security  Users  Modify 
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o Trên máy B:  
Ánh xạ thư mục chia sẻ software của máy A thành ổ đĩa W lần lượt với tài 
khoản userXX và adminXX của máy A 
 

 
 

 Kiểm chứng khả năng ghi, đọc, xóa,… trên W 
 Câu hỏi:  

Ý nghĩa của user limited, permissions ? 
Sự khác biệt giữa sharename và foldername ? 

o Trên máy A: Thực hiện chia sẻ sau: 
Thư mục F:\data 

 Sharename:   data 

 user limit:  4 

 permissions:  sinhvien    Change 

everyone    remove 
 

o Trên máy B:  
Ánh xạ thư mục chia sẻ data của máy A thành ổ đĩa X lần lượt với tài khoản 
userXX và adminXX của máy A 

 Kiểm chứng khả năng ghi, đọc, xóa,… trên X 
 Câu hỏi:  

Sự khác biệt giữa Full Control, Change và read? 
b. Share printer 

o Trên máy A:  
Right click máy in HP LaserJet 6L  chọn Sharing…  Đánh dấu chọn 
Share this printer với: 

 Sharename: HP_Laser_6L 

 Security: everyone    remove 

admingroup   namage Printers, 
print 

sinhvien    print 
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Tương tự với máy in HP LaserJet 6P 
 Sharename: HP_Laser_6P 

 Security: everyone    remove 

admingroup   namage Printers, 
print 

 

o Trên máy B:  
Lần lượt cài đặt các máy in mạng với các tài khoản khác nhau của máy A 

 Câu hỏi:  
Sự khác biệt giữa print và manage printers ? 
Tại sao userXX không cài được máy in HP_Laser_6P ? 

2. Offline Files 
o Trên máy B:  

Cho phép chức năng offline file: Trên Windows Explorer  Tools  

Folder options  Offline files  Đánh dấu chọn Enable 
Offline files  OK 

 
 

 Trên ổ đĩa X, tạo lần lượt các tập tin test01.txt, test02.txt. 
 Right click text01.txt  Chọn make available offline 

Disable card mạng: Right click My Network places  Cho card 
mạng đang sử dụng  right click  Chọn disable 

 Quan sát lại nội dung trên W và X  nhận xét 
 Sửa nội dung trên tập tin test01.txt  lưu lại 

Enable card mạng: Right click My Network places  Cho card mạng 
đang sử dụng  right click  Chọn enable 
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 Quan sát quá trình đồng bộ file 
 Quan sát lại nội dung trên W và X  nhận xét 

 Câu hỏi:  
Cho biết chức năng của offline files ? 

o Trên máy A:  
Right click trên thư mục F:\Soft  chọn Sharing and Secirity…  

Sharing  chọn caching  Trong ô Settings chọn Automatic 
caching of programs and document 
 

 
 

 Chép các ứng dụng và file sau vào f:\soft 
• Adminpack.exe 
• WinRAR 3.0 Full 

• Test03.txt (sinh viên tự tạo) 
o Trên máy B:  

Lần lượt thực thi các tập tin sau: 
• Adminpack.exe 

• Test03.txt 

Disable card mạng:  
 Quan sát lại nội dung trên W  nhận xét 
 Sửa nội dung trên tập tin test03.txt  lưu lại 

Enable card mạng:  
 Quan sát quá trình đồng bộ file 
 Quan sát lại nội dung trên W  nhận xét 

 Câu hỏi:  
Cho biết chức năng của Automatic caching of programs and 

document? 
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Bài 4: Windows 2003 server trong môi trường workgroup 
 

Hai máy tạo thành nhóm thực tập: máy A (Windows 2003 server) và máy B (Windows 
XP) 
Máy A lần lượt tạo:  (XX là số theo thứ tự của máy) 
 Thư mục: C:\software 
   C:\data 

1. Một số công cụ quản trị trên Windows 2003 server 
a. Computer management 

o Trên máy A:  
 Start / Programs / Administrative tools  Computer 

management. Lần lượt tạo các user và group như sau: 
 Các user:  userXX   password: 1234 

adminXX   password: 1234 

 Các group: sinhvien có thành viên là userXX, adminXX 
   Admingroup có thành viên là adminXX 
 Vào Shared folders / shares  Quan sát các chia sẻ trên 

server bao gồm Share Name, Folder Path 
 

 
 

b. Local security policy 
o Trên máy A:  

User rights Asignment: 
 Logoff  logon bằng userXX  Có thực hiện được ? 
 Logoff  logon bằng administrator:  
Administrative tools  Local security policy  Local 
policies / User rights Assignment / chọn Allow logon 
locally  Loại bỏ nhóm Users 
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 Vào Run  gpupdate  enter 
 Logoff  logon bằng userXX  Có thực hiện được ? 
 Quan sát một số quyền khác trong User rights Asignment 

Security option: 
 Administrative tools  Local security policy  Local 

policies / Security Options  cho phép tính năng Shutdown: 
Allow system to be shutdown … 

 

 
 

 Logoff  Kiểm tra xuất hiện mục Shutdown trên màn hình logon 
 Quan sát một số tính năng khác trong security Option 

c. Remote desktops: 
o Trên máy A: Cho phép tính năng Remote desktop 

 Right click My Computer  Properties  Remote Đánh 
dấu chọn Allow users connect remotely to this computer 
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o Trên máy B:  Remote desktop đến máy A 
 Programs / Accessories / Communications / Remote 

desktop connections Nhập tên máy A  đăng nhập bằng 
administrator của máy A 

 

 
 

 Thực hiện một số thao tác quản trị  Việc thao tác đồng th i giữa màn 
hình remote desktop và màn hình của máy A có ảnh hư ng gì không 
? 

 Câu hỏi:  
Cho biết chức năng của Remote desktop connections trên máy B? 

o Trên máy B:  Cho phép tính năng Remote desktop 
o Trên máy A:  Remote desktop đến máy B như sau 

 Administrative tools / Remote desktops  Chọn Remote 
desktops  Right click và chọn Add new connection… 
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Lần lượt nhập các thông tin của máy B 
  Server name:  STU-XXS 
  Connection name: to STU-XXS 
  User name:  administrator 
  Password:   123456 
 

 
 

 Kiểm tra một số thao tác qua remote desktops 
 Thực hiện thêm mốt số kết nối đến một số máy B của nhóm khác 

 Câu hỏi:  
Cho biết chức năng của Remote desktops trên máy A? 

d. Event viewer: 
o Trên máy A:   

 Administrative tools / Event Viewer 
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 Quan sát các cảnh báo 

e. MMC: 
o Trên máy A:   

 Run  mmc  enter 
 Trên cửa sổ Console  chọn File  Add/remove Snap-in  

Chọn Add  Lần lượt thêm các công cụ sau: 
Device Manager 
Disk Management 
Event viewer 
Local Users and Groups 
Remote Desktop 
Shared Folders 
 

 
 

 Sử dụng các công cụ trên console  nhận xét mục đĩch của MMC 
 Lưu console lên desktop với tên admintools 
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2. File server: 
a. Chia sẻ 

o Trên máy A:  
Right click trên thư mục C:\Software  chọn Sharing and 

Secirity…  Sharing  Đánh dấu chọn Share this folder  Các 
thông số: 

 Sharename:  software 

 permissions:  everyone    Full control 

Chọn tab Security  
 permissions:  User     remove 

sinhvien    read & execute 

admingroup   Modify 
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Right click trên thư mục C:\data  chọn Sharing and Secirity… 
 Sharing  Đánh dấu chọn Share this folder  Các thông số: 

 Sharename:  data 

 permissions:  everyone    Full control 

Chọn tag Security  
 permissions:  User     remove 

Tạo thêm các thư mục: C:\data\userXX, C:\data\adminXX 

Right click trên thư mục C:\data\userXX  chọn Sharing and 

Secirity…  security  Các thông số: 
UserXX   modify 

Right click trên thư mục C:\data\adminXX  chọn Sharing and 
Secirity…  security  Các thông số: 

adminXX   modify 

    
 

o Trên máy B:  
Ánh xạ thư mục chia sẻ trên máy A với tài khoản userXX của máy A 

W     \\server-XX\software 

Y     \\server-XX\data\user19 
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 Kiểm chứng khả năng ghi, đọc, xóa,… trên W và Y 
Ánh xạ thư mục chia sẻ trên máy A với tài khoản adminXX của máy A 

W     \\server-XX\software 

Y     \\server-XX\data\admin19 

 Kiểm chứng khả năng ghi, đọc, xóa,… trên W và Y 
b. Disk quotas: 

o Trên máy A:  
Right click trên ổ đĩa C:\  Properties  tab Quota  Đánh dấu 
chọn: 

 Enable quota management 
 Deny disk space to users exceeding quota limit 
 Log event when … quota limit 
 Log event when … warning level 

Chọn tiếp Quota Entries… 

 
Trên cửa sổ Quota Entries chọn Quota / New quota entry…  Lần 
lượt thêm 2 entry cho 2 user: 

userXX   limit disk space to:  1 MB 
   set warning level to:  0.9 MB 

adminXX  limit disk space to:  1 MB 
   set warning level to:  0.9 MB 
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o Trên máy B:  
 Quan sát dung lượng ổ đĩa Y  nhận xét 
 Chép thư mục WinRAR 3.0 Full vào Y 

o Trên máy A:  
 Xem cảnh báo trong Event Viewer là gì ? 

o Trên máy B:  
 Chép thêm tập tin adminpack.exe vào Y  Nhận được cảnh báo gì ? 

o Trên máy A:  
 Xem cảnh báo mới trong Event Viewer là gì ? 

 Câu hỏi:  
Cho biết chức năng của Disk Quota? 

3. UTP cable và kỹ thuật bấm cáp 
o Sinh viên thực hiện bấm cáp UTP CAT 5e với 2 đầu là chuẩn B 

Tr.cam    cam    tr.xlá    xdương    tr.xdương     xlá    tr.nâu    nâu 
o Kiểm tra cáp sau khi bấm 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

T568A: tr.xlá      xlá      tr.cam  xdương    tr.xdương     cam    tr.nâu    nâu 

T568B: tr.cam    cam    tr.xlá    xdương    tr.xdương     xlá       tr.nâu    nâu 
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Bài 5: Dịch vụ trên Windows 2003 server  
 

Hai máy tạo thành nhóm thực tập:  
máy A (Windows 2003 server, có 2 card mạng) 
máy B (Windows XP, có 1 card mạng) 

Được nối mạng sẵn như sau: 

 
Lần lượt khai báo tĩnh các địa chỉ IP của server như hình vẽ (XX là số thứ tự của máy) 

1. DHCP server: 
a. Cài đặt DHCP service: 

o Trên máy A:  
 Đặt một địa chỉ IP tĩnh cho máy A. 

 

 
 
 Vào Administrative tools / Configure your Server Wizard  Next  

Next 
 Chọn DHCP server  Next  Tiến hành cài đặt …  
  cửa sổ New Scope Wizard  Next 
 Trong cửa sổ Scope Name, gõ “Scope1” vào ô Name 
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 Trong của sổ IP Address Range nhập các thông số về khoảng địa chỉ 
mà Scope1 sẽ cấp phát với Start IP address: địa chỉ đầu, và End IP 
address: địa chỉ cuối.  Next 

 Trong cửa sổ Add Exclusion, nhập khoảng địa chỉ mà sẽ không được 
cấp phát b i DHCP server.  Next 

 

  
 

 Trong cửa sổ Lease Duration  Để nguyên giá trị mặc định  Next 
 Trong cửa sổ Configure DHCP Option, đánh dấu chọn vào tùy chọn No, 

I will configure these options later.  Next  Finish 
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 Vào Administrative tools / DHCP để tiếp tục cấu hình DHCP server 
 

 
 

 Click chuột phải lên Scope1 (Scope mới được tạo  các bước trên)  
Chọn Activate. Quan sát biểu tượng của scope. 

 

 
 

 Click chuột phải lên Scope1 -> chọn Configure Options… 
 

 
 

 Trong cửa sổ Scope Options -> Tab General -> đánh dấu chọn vào ô 
003 Router -> Trong ô IP address gõ địa chỉ của DHCP server -> Chọn 
Add -> Apply. 

 Tiếp tục đánh dấu chọn vào ô 006 DNS Server -> Trong ô IP address 
gõ địa chỉ của DNS server -> Chọn Add -> Apply. 
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 Kiểm tra các Option vừa mới được tạo 
 

 
 

b. Cấu hình DHCP client 
o Trên máy B:  

 Log on vào Administrator -> M  properties của LAN Card -> M  
properties Internet Protocol (TCP/IP) -> đánh dấu chọn vào hai ô 

• Obtain an IP address automatically 
• Obtain DNS server address automatically 

 Chọn OK -> Close 
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 Vào Command line -> lần lượt nhập các lệnh:  
ipconfig /release   
ipconfig /renew 
ipconfig /all 

 Quan sát các thông số của card mạng 
 Nhận xét kết quả? 

 

 
 

2. DNS server: 
a. Cài đặt DNS service 

o Trên máy A:  
 Vào Administrative tools / DHCP và cấu hình các Option 003 Routers, 

006 DNS Servers, 015 DNS Domain Name 
 

  
 

 Vào Administrative tools / Configure your Server Wizard  Next  
Next 

 Chọn DNS server  Next  Tiến hành cài đặt …  
  cửa sổ Configure a DNS Server Wizard -> Next 
  cửa sổ Select Configuration Action chọn tùy chọn Create forward and 

reverse lookup zones -> Next 
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  cửa sổ Forward Lookup Zone chọn tùy chọn No, don’t create a 

forward lookup now -> Next 
  cửa sổ Forwarders nhập địa chỉ IP của DNS server mà server này sẽ 

g i truy vấn nếu nó không thể trả l i   -> Next 
 -> Next -> Finish 

 

  
 

  
 

b. Forwarders và RootHints 
o Trên máy A:  

 Vào Administrative tools / DNS để m  DNS server 
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 Trên DNS sever, click chuột phải và chọn Properties từ popup menu 

 
 

 Chọn tab Forwarders để xem và hiệu chỉnh các địa chỉ IP của 
Forwarders nếu muốn. 

 Chọn tab Root Hints để xem các địa chỉ IP của các Root Hints 
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o Trên máy B:  

 Cấu hình DHCP Client Service nhận địa chỉ IP và DNS server động. 

 
 Tại Command line lần lượt nhập các lệnh sau và quan sát kết quả: 

ipconfig /flushdns 
ipconfig /displaydns 
ping www.tuoitre.com.vn 
ipconfig /displaydns 

Câu hỏi:  
- Cho biết ý nghĩa của các lệnh ipconfig /flushdns, ipconfig /displaydns 
- Giải thích sự khác nhau của kết quả hiển thị của lệnh ipconfig /displaydns trước 

và sau khi thực hiện lệnh ping www.tuoitre.com.vn 
o Trên máy A:  

 Chọn menu View -> Advance -> Quan sát Cache lookups 
 Nhận xét kết quả? 

 
 

 Trong tab Forwarders, bỏ các địa chỉ IP và sau đó chọn tab Root Hints 
và quan sát. 

o Trên máy B:  
 Tại Command line lần lượt nhập các lệnh sau và quan sát kết quả: 

ipconfig /flushdns 
ipconfig /displaydns 
ping www.tuoitre.com.vn 
ipconfig /displaydns 
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Câu hỏi:  
- Cho biết ý nghĩa của các Forwarders và RootHints? 
o Trên máy A:   

 Trong tab Forwarders, nhập lại các địa chỉ IP của Forwarders. 
c. Forward lookup zones 

o Trên máy A:  
 Vào Administrative tools / DNS để m  DNS server 
 Click chuột phải vào Forward lookup zones và chọn New Zones… 
  

 
 

 Chọn Primary zone -> Next -> Nhập zone name là nhomXX.com (XX là 
số thứ tự của  máy) -> Next -> Giữ nguyên tên file mặc định -> Next -> 
Chọn Allow both nonsecure and secure dynamic updates -> Next 
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 Quan sát zone vừa tạo. 

 
d. Reverse lookup zones 

o Trên máy A:  
 Click chuột phải vào Reverse lookup zones và chọn New Zones… 

 

 
 

 Nhập Network ID tương ứng với zone vừa tạo  trên -> Next -> Giữ 
nguyên tên file mặc định -> Next -> Chọn Allow both nonsecure and 
secure dynamic updates -> Next 
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 Quan sát zone vừa tạo 
 

 
 

e. Records: A, CNAME, PTR 
o Trên máy A:  

 Trong Forward lookup zones click chuột phải vào zone nhomXX.com và 
chọn New Host (A) 

 

 
 

 Nhập computer name của máy B (STU-XXS) và địa chỉ IP tương ứng -> 
Add Host. Có thể chọn Create associated pointer (PTR) record để tạo 
con trỏ tương ứng  Reverse Lookup Zones 
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 Quan sát Host vừa tạo 
 

 
 

 Trong Reverse lookup zones click chuột phải vào 192.168.XX.x Subnet 
và chọn New Pointer (PTR) 

 

 
 

 Nhập Host IP của máy B (STU-XXS) và Host name tương ứng (hay 
cũng có thể chọn Browse… để tìm Host) -> OK.  
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 Quan sát Pointer vừa tạo 
 

 
 Trong Forward lookup zones click chuột phải vào zone nhomXX.com và 

chọn New Alias (CNAME) 
 

 
 

 Nhập Alias của máy A là www (máy A sẽ làm Web server) và FQDN 
tương ứng (hay cũng có thể chọn Browse… để tìm Host) -> OK.  
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 Quan sát Pointer vừa tạo 

 
 

 Nhấp phải My Computer trên Desktop -> chọn Properties -> chọn tab 
Computer Name -> chọn Change… -> nhập tên của máy A SERVER-
XX -> chọn More… -> nhập vào Primary DNS suffix cho máy A là 
nhomXX.com -> OK. 
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o Trên máy B:  
 Tại Command line lần lượt thử phân giải các tên dùng lệnh nslookup: 

nslookup 
server-XX.nhomXX.com (XX là số thự tự của máy) 
www.nhomXX.com 
stu-XXs.nhomXX.com 
 Quan sát kết quả 

 
 

o Trên máy A:  
 Trong cửa sổ DNS, nhấp phải tên server -> All Tasks -> Stop. 
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o Trên máy B:  
 Tại Command line lần lượt thử phân giải lại các tên dùng lệnh nslookup 

Câu hỏi:  
- Nhận xét kết quả phân giải tên? 
- Cho biết ý nghĩa của các record A, PTR, CNAME?  

 
3. WEB and FTP server 

a. IIS 
o Trên máy A:  

 Vào Administrative tools / Configure your Server Wizard  Next  
Next 

 Chọn Application server (IIS, ASP.NET) và tiến hành cài đặt. 
 

 
 

b. WEB 
o Trên máy A:  

 Tạo thư mục C:\wwwroot và copy một file .htm vào thư mục này, đổi tên 
file lại thành index.htm hay default.htm 

 Vào Administrative tools / Internet Information Services (IIS) Manager  
 Chọn Web Sites và click chuột phải để tạo New Web Sites 

 

 
 

 Nhập tên mô tả cho Website và đư ng dẫn chứa Website -> Next 
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 Đánh dấu chọn các mục Read, Run scripts, Browse -> Next 
 

 
 

o Trên máy B:  
 M  Internet Explorer và thử truy cập vào địa chỉ của Web server: 

www.nhomXX.com (tương ứng với alias đã tạo  trên) 
 Nhận xét kết quả. 
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